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Review: Cricket Draw and Illustrator 

rectangles and ovals to squares and circles, respec­
tively. The Arc tool is a new tool that is similar to 
drawing an oval or rectangle. A Diamond tool is also 
included, and it is used the same as other tools. 
Defining a Polygon is different than defining any of 
the previous objects. To use the Polygon Tool click 
where desired to start the object, then click to define 
each of the vertices of the object. Double click to leave 
the object open or click back at the beginning of the 
object to close it. Totally new tools for any drawing 
package are the Grate and Starburst Tools. Grates 
provide a useful and quick way to design business 
forms and graph paper, even log x log paper. The 
Starburst tool creates a set of lines radiating outward 
from a central point. Using the Shift key to constrain 
the starburst to a circle and then connecting the end­
points of the starburst is a fast way of developing a 
regular polygon. 

Bezier Curves can be created within Cricket 
Draw but not with the power of Illustrator. To draw a 
Bezier curve, select the tool and click at the the first 
control point of the curve. Continue to click at the 
remaining three control points. When completed with 
the last point, a smooth curve is drawn by the applica­
tion. Dragging a curve's endpoints does not move the 
control points, and no capability to edit the curve by 
dragging on it are provided (as in Illustrator). 

Object Control icons are presented at the bottom 
of the screen. The first is the Fill Control, and click­
ing on it presents a dialog box that controls Fill Inten­
sity and Color. The user can create an object that is 
not filled, and an object can be filled with white. 
Option click on Fill Control gives a dialog box to 
access the POSTSCRIPT "transfer" modes, i.e. the 
operators setscreen and settransfer. From 
here the user can select Dot or Line screen frequen­
cies and angles for Normal, Poster, or Negative 
transfers. However the dialog doesn't allow control of 
both the screen and transfer mode at the same time 
(cannot create a negative with a line screen other 
than the default). There are no screen representa­
tions of these transfer modes. The next icon gives 
access to Line Control including Line Width, Inten­
sity, Color, and Line Style. Line intensity can vary 
between zero and 100 in one percent increments and 
ten line styles are supported. Finally, the last three 
controls, Duplicate, Rotate, and Tilt, are provided as a 
convenience here. 

ILLUSTRATOR 

The Package 

Illustrator is shipped on two SOOK disks consisting of 
a copy-protected Program disk and a Tutorial disk. 
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Also included is an excellent 229-page hardcover 
User's Manual set in type from Adobe's library and 
produced with POSTSCRIPT on a Linotype L300. The 
manual has six Chapters: Introduction, Tutorial, 
Feature Description, Tips & Tactics, Reference, and 
POSTSCRIPT. Appendices include Key Sequences, 
Preset Options, Memory Usage, and Problems & Solu­
tions. The manual concludes with a six-page Glossary 
and an Index. Unique to Illustrator is a 30-minute 
informal session with the president of Adobe Systems 
on VHS tape, a three-page foldout quick Reference 
Card, and a Registration Card. Adobe encourages 
registering Illustrator by offering an unprotected ver­
sion which is then personalized with the user's com­
pany name and the software serial number. All docu­
ments created with the unprotected version contain 
this information as comments. A subscription to the 
graphics newsletter Colophon, customer support for 
60 days, product updates for 90 days, and two artwork 
disks are additional rewards for registration. The list 
price of $495 is justified. 

System Requirements 

The minimum configuration to run Illustrator is a 
512Ke further enhanced up to at least lM of memory. 
As with most recent applications, a hard disk is also 
recommended. Clipart, a digitizer, or a scanner can 
provide a source of bitmapped graphics for the artist 
to use as base artwork to trace. 

Operation 

The initial operation of Illustrator can be intimidat­
ing. The tools seem sparse and they are certainly 
new. Adobe has anticipated this and have included 
269K (!) of practice files. However, the application 
itself is not needed to print any previously-generated 
artwork, since they are normally saved as text files. 
Any POSTSCRIPT downloader can be used, and one is 
even included on the artwork disks. Be sure to check 
the Add Showpage option if available, or add a 
showpage using a text editor before downloading to a 
POSTSCRIPT device. 

The "native mode" is to trace a bitmap or PICT 
template. A user can also create freehand artwork, 
but the software was not designed with this in mind. 
Correspondingly, Illustrator opens paint documents 
and displays them at 50% gray. The User's Manual 
and samples follow a convention using suffixes of"art" 
or "template" to differentiate files and opening a docu­
ment gives an Artwork & Template View if this is fol­
lowed. The application opens the 14 x 14-inch docu­
ment in the middle of the drawing; however, launch­
ing the application does not bring up an Untitled 
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document. No facility exists to open POSTSCRIPT text 

files directly, but a Desk Accessory can be used to 
open and edit small files if desired. Illustrator will 

not open POSTSCRIPT or EPSF files generated from 
Cricket Draw even if the File Creator is changed to 

the name needed. The software is very robust, and 
with a few exceptions, Illustrator is a model applica­

tion. 

Online Help 

As with the complete Adobe Illustrator package the 
Online Help feature is well (if not over) done. It con­
sists of two main folders: Help with Commands and 

Help with Tools. Help with Commands also contains 
two additional folders for help with the Paint and 

Type dialog boxes. All panels are complete with cross 
references, and graphics are also used where neces­

sary. These folders can be opened from under the 
Apple or from all Illustrator dialog boxes. All desk 

accessories are dimmed when in this help feature, but 
this doesn't seem to be much of a drawback. (The 

DA's are also dimmed when the Constrain, Paint, or 
Type dialog boxes are displayed; this is a little discon­

certing.) The only criticism that can be made about 
the online help feature is that it isn't context sensi­

tive. Collectively the Help ... feature consists of 78 
files and is over 485K in size, by far the most 
comprehensive and useful of any Macintosh applica­

tion. 

Menus 

Unlike Cricket Draw, Illustrator has only a single 

windowing environment and a single menu. The 

application does support multiple windows, and the 
user can move a non-active window (Command drag) 

without having it become active. This capability is 

just like in the Finder. Also implemented is a new 
feature to send an active window to the back 
(Command-click title bar). However, a pulldown 
menu to manage multiple windows would be simpler. 

Within the application, Illustrator does not allow 

you to view the POSTSCRIPT code as text. However, its 
documents are maintained as pure POSTSCRIPT that is 
both read and written by the application. The prolo­

gue used by Illustrator provides both compact and 

powerful code, but it also detracts from the readabil­
ity. Adobe's Document Structuring Conventions (2.0) 
are implemented within Illustrator. This means that 
a document can be edited in a manner that will not 
affect the file's readability as far as the application is 

concerned. The comments %%BeginDocument and 
%%EndDocument are provided for this purpose and 
can be used to surround the handwritten code. 
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Nearly all selections have corresponding Com­
mand key definitions. These keys are well chosen and 

do not conflict or disagree with those accepted (by 
default) in the majority of Macintosh applications. As 

with any Macintosh application these Command keys 
exist as resources and can be redefined. This is 
beyond the scope of this article but can be found in 
various related computer magazines. 

The first of the pulldown menus for the applica­
tion is File. It contains the well known selections that 
pertain to entire documents. Choosing New from File 
displays a dialog box asking the user to choose a tem­
plate as base art for a new document. The New com­
mand does not give a Cancel button nor a method to 
bypass the dialog box and immediately opens a new 
document without a template. Three formats (and 
three icons) exist to save files: POSTSCRIPT Only, 
EPSF for Macintosh and EPSF for IBM, and these 
three formats can be opened in any combination from 

the desktop. All menu selections within Illustrator 
are well behaved. For example, with a LaserWriter 
not selected from Chooser, Print... is dimmed and 
with no print drivers installed, Page Setup ... gives an 
alert to select a print driver from the Chooser. 

Finally, depressing the Option key when selecting 
Print... skips the dialog box for changing printing 

options and immediately uses the last selection. 
The Edit menu contains the same Cut and Copy 

as other applications and puts the selected objects to 

the Clipboard. However, if Show Clipboard is chosen 

the user sees that the Clipboard only gives the 
number of objects copied, e.g. "l artwork objects" 
(sic). This is probably due to a limitation or conflict of 

the POSTSCRIPT screen driver that is used instead of 
QuickDraw to draw objects to the screen. Also new is 
the capability of Undoing a Clear and the capability 
to Paste in Front and Paste in Back of a currently 

selected object. For these last two features the newly 
pasted objects become selected, and all other objects 
are deselected. The new objects are abo placed at the 
same location from which they were cut or copied. 
There is no Revert to last saved version implemented 

under the Edit menu. 

The Arrange menu has commands to control the 
arrangement of objects that are Undoable. The Join 
selection is used to connect two ungrouped points with 
a straight line segment, but if exactly two points 

aren't selected, the selection should be dimmed and 
isn't. Average is similar to Join: it moves two or more 
selected anchor points to a new position which is the 
horizontal and vertical average of the selected points. 
Align Objects isn't available as a pulldown menu; 
alignment must be done manually by drawing 

crosshairs or aligning center points of objects, but this 
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can be simplified by using the Snap to Point option 

within the Constrain ... selection. The default is with 
Snap to Point selected. 

The View menu allows the user to select one of 
four viewing modes including Preview, Artwork & 
Template, Artwork Only, or Template Only. The Pre­
view mode is a POSTSCRIPT preview of the artwork 
and can be updated in near real time when the art­
work is changed. The remaining views show the base 

art and/or artwork in the active window as their 

names imply. A Template Only view does not allow 
any editing. The Select Actual Size and Fit in Win­
dow selections also do as their names imply, but after 

selection of either I would like to see it dimmed until 
the size is changed again. New View creates another 
window that can be changed into any viewing mode as 
listed above. Show/Hide Rulers and Hide/Show Tool­
box are also familiar to users of other Macintosh 

applications. The zero point of the Rulers can be 
moved to any spot on the page and their intersection 
shows an icon that displays the level of magnification 
or reduction. 

The last menu, Style, gives access to dialog boxes 
to set or change the paint attributes of objects as well 
as control the attributes of type objects. These dialogs 
support Cut, Copy, and Paste from the pulldown 
menus and Command keys, but not Show Clipboard. 
From the dialogs the user can access the help files. 

Each box does its corresponding error checking on 
input data when OK is selected, and both handle mul­
tiple errors correctly. 

Choose Paint... to control the way objects are 
filled and/or stroked. The user can select None, 
White, %Black, or percentages of any of the three pro­
cess colors for filling or stroking any object. Line 
Caps, Line Joins, and Stroke style can also be 
specified. The Stroke style can be up to a six-element 

array but no offset can be specified through the dialog. 
The Paint ... dialog should also implement a clipping 

path, but this could be due to the fact that clip does 

not implicitly perform a newpath after it is finished 
with the current path (fill and stroke do). The Flat­
ness parameter is also presented to control the draw­
ing and printing speed of very complex curves. The 
default setting is 0, which allows Illustrator to substi­

tute 1 and all POSTSCRIPT printers substitute their 

own preset flatness parameter. If this is set to any 
number both Illustrator and the printers will use that 
specified value. 

The Type ... dialog box is a feature of Illustrator 
that could use some more advanced capabilities. 

Currently it allows the ability to set POSTSCRIPT fonts 
in sizes between O and 1008 points with left, right, or 
center (but not full) justification. It also allows the 
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user to specify positive or negative leading and track 

kerning. However, Illustrator does not support pair­
wise kerning since it does not read the Adobe (!) Font 

Metric files. Manual kerning must be done by using 
separate Type blocks. Up to 254 characters can exist 

in a block but styles can not be mixed and no word 
wrap exists within the block. Finally, type can be 
scaled with a scaling tool but only the initial font is 
used on screen. After scaling, the display will look 

very poor or even useless. No way to specify x and y 

scaling of type exists beyond using the scaling tool. 

After scaling, the type can be resized from the dialog 
box in only the y direction (x scaling remains 
unchanged). 

Tools 

The Illustrator Toolbox contains 13 icons that 
represent tools used to draw, move, and transform 

objects. The Toolbox can be repositioned by dragging 

and can be closed but cannot be placed behind a win­
dow. Keyboard equivalents exist to temporarily 

access the tools used to control object and screen 

movement, and these work even if Toolbox is hidden. 
When drawing, the window automatically scrolls to 
keep the current tool on the screen. Let's look at each 
tool separately. 

The Selection Tool is used to designate objects 
and anchor points, segments, and type. With a object 

selected, holding the Option key when picking the 
Selection Tool gives a move dialog box where the user 
can specify horizontal, vertical, or angular movement. 
The Selection tool gives the user a variety of ways to 
edit Bezier curves. One can pull on a curve to keep 
constant anchor points but lengthen direction vectors, 

drag either anchor point but still maintain its relative 
control point, drag a direction point to give more 
"velocity" to the curve or spin a direction point to 

change a curve's initial direction. All curve editing is 
displayed in real time. 

The Hand Tool is used to move about the page. 
Double clicking the Hand Tool fits the complete docu­
ment in a window. Four levels of magnification and 
four levels of reduction can be achieved with the Zoom 
Tool. After selection, a mouse click initiates the zoom, 
keeping the mouse button down gives the Hand Tool, 

and the new magnification can be repositioned. The 

Option key is available to change the tool to zoom out 
(back away). A double click on the tool zooms in about 

the center of the window, and Option double click 
zooms out about the center of the window. 

The Pen Tool and its power to draw Bezier 
curves and straight lines is the specialty of Illustra­
tor. Selecting the Pen Tool is the POSTSCRIPT 
equivalent of "newpath" and forces the cursor to 
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become an x. Move the cursor, click at the desired 

anchor point and drag to create a tangent direction 

vector and the first control point. Release the mouse 
button and the cursor becomes a plus sign. Click at 

the curve's inflection point or endpoint and drag to 

create a second control point. The position of the cur­

sor is exactly opposite of this second control point and 
actually forms a possible control point for the next 
curve. The technique is difficult to explain here, but 
is addressed well in the documentation and video 

tape. With practice the Pen Tool can be used to create 
paths with changing curvature, corner points, and 
cusps. 

Using Illustrator's Type Tool, the user can add 
type to any drawing. When creating type, the user 

marks the baseline and alignment point with the cur­

sor, and the application responds by displaying a dia­
log box to enter or edit the type. A block of type is 
treated as an object and therefore can be painted, 

stroked, rotated, scaled, sheared, and so on. 
The Square and Circle are the only traditional 

looking tools within the Toolbox, but again even these 

simple tools act far beyond what you would expect. 
Specifically, a square or circle can be Ungrouped into 
four pieces and further edited. However to rescale 
either visually (as opposed to mathematically) the 
object has to be Ungrouped and then Grouped again if 
needed. For both tools, holding the Option key allows 

drawing from the center. 

To split a path into two paths or break a closed 
path into an open path the user can pick the Scissors 

Tool. Additionally, the Scissors can be used with the 
Option key when clicking on any curve to insert an 

anchor point along any path segment. Other tools for 
object transformations include Scale, Rotate, Reflect, 
and Shear. These tools can be used on text as well as 

other objects, as mentioned before; however, scaling 
and rotation are reflected in the POSTSCRIPT code not 
as operators but as absolute data points. Keeping the 

Option key depressed while selecting a reference point 

with any of these tools gives a dialog box for an exact 
modification using that tool. These dialog boxes can 
also produce copies of objects, or option Drag can also 

produce copies of objects, thus preserving the original. 
Finally, the Page tool can be used to tile the 14 x 14 
image into four or nine pages as needed. 

Conclusion 

The two applications reviewed here have targeted two 
separate positions in the Macintosh software market. 

Each should hold their position strongly for some time 
to come. The review included testing Adobe Illustra­

tor version 1.1 and Cricket Draw vl.01. Both pack­
ages represent the current release at the time of this 
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review. Hardware used during testing included a 

Macintosh 512Ke with a Hyperdrive 2000 upgrade (12 
MHz 68000, math coprocessor, 2M memory, and a 
20M internal hard disk) running version V3Rl drive 

software and an Apple LaserWriter Plus (POSTSCRIPT 
interpreter version 38.0) with AppleTalk. Finder 5.3, 

System 3.2, and 3.1 printer drivers were used. Macin­
toshes and peripherals other than those listed were 
not tested. Integration with other applications and 
file transfer formats including EPSF, PICT, and Clip­
board were not tested either. 

The author is currently a Senior Project Engineer 
developing drive firmware for a Write Once Read 
Many (WORM) optical disk. He also has previous 
experience in Man Machine Interface design. The 
author enjoys exploring the uses of POSTSCRIPT in 
typesetting and commercial graphics and would wel­
come any programming or printing jobs. 

Warren Jokinen 
984 Zamora Circle 
Colorado Springs, CO 80910 
303 I 637-1479 

Editor's Note: 

We spoke with Doug Seward at Cricket 
Software about the new Cricket Draw version 

1.1 that they started shipping in mid-October. 
He told us that many of the problems and 
bugs pointed out in this review have been 

fixed, and that the new version is much faster 

than the old one-up to ten times as fast. He 
also told us that printer timeouts are now rare 
due to a new downloading method. 

Specifically, the bugs that weren't fixed are 
the errors in the PcstScript. help file and 

the problem of not being able to set both the 
transfer and spot functions at the same time. 

He also said that there were no changes made 
to the way splines are drawn or edited. 

Although color separation was announced as a 

capability of version 1.1, Doug told us that it 
will not be available until a later release. 
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